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50: العملي50: النظري 

.تحتاج للتجريب والتدريب والدراسة بشكل ذاتي منزلي وخلال الجلسات

الاختبارات وتوزيع الدرجات وطريقة التقييم
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%15السابعفي الأسبوع 1تحريري اختبار 

%15في الأسبوع الثاني عشر2حاسوبي اختبار 
ي فأمام لجنة حكمعرض تقديميمشروع تطبيقي بحثي يتضمن 

%20الأسبوع الرابع عشر

%50كتابيامتحان نهائي

https://manara.edu.sy/


الموضوعات الرئيسة التي يغطيها المقرر 
القسم الأول 

الدكتور فاديمفردات التي سيعطيها 
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.Eagle and Altium Designerالتصميم الإلكتروني برامج •

بمحرك تيار مستمر وبدرجة الحرارةPIDالمقاطعات والتحكم •

في المتحكمات وتوظيفهاالتايمرات•

قيادة روبوت على عجلات تخطيط مسار وتحكم حركة•

•ROS2

الموضوعات الرئيسة التي يغطيها المقرر 
القسم الثاني

عيس ىمفردات التي سيعطيها الدكتور 
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المشروع

للوصول إلى آخر المسارروبوتينمنافسة بين •

.توزع النقاط عل التصميم وعلى التنفيذ والبرمجة وإنجاز المهام•

.هولة نسبيااستخدام تقنيات حساسات مركبة على روبوت تفاضلي بعجلات عادية للتعرف على بيئة مج•

(خط أسود)الروبوت مقيد بالمش ي على مسار مرسوم •

كة الروبوتالبيئة عبارة عن حلبة تحوي عوائق تكون موضوع بجانب أو على الخط الأسود بحيث تعيق حر •

.العوائق عبارة عن علبة كرتونية لا يجب أن يصطدم الروبوت بها•

عندما يصادف الروبوت عائق عليه العودة إلى تقاطع ليجرب مسار آخر حتى الوصول للأخير•

.يجب على الروبوت تجاوز شرط فجائي معين•
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:الغاية من هذه المحاضرة
.لتصميم دارة الكترونية مطبوعة EAGLEتعليم استخدام برنامج 

Schematicتعلم •

PCBتعلم •

قواعد التصميم الإلكتروني•

فحص الأخطاء•

.باستخدام هذا البرنامج1الغاية النهائية تصميم دارة المشروع لمادة تطبيقات 
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PCB Technology

PCB Assembly services are a fundamental part of the 
manufacturing of electronic devices to ensure their utility and 
competence.

A PCB is an electronic part used to assemble electrical 
components into various machines and hardware.

These machines are commonly found in the advanced gadgets on 
which we are vigorously reliant today, like Television, Drivers, 
motors, Games, PCs, phones, and laptops.

• Low Cost Overall With PCB Assembly
• Human Error Is Reduced
• Product Development Cycle Has Been Reduced
• Reliable Quality
• Fit For Mass Production الانتاج الشامل
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1. Surface-mount technology (SMT) is a method in which the electrical components are mounted directly onto the surface of a printed circuit board 
(PCB). An electrical component mounted in this manner is referred to as a surface-mount device (SMD). In industry, this approach has largely replaced 
the through-hole technology

In microelectronics, a dual in-line package (DIP or DIL), is an electronic component package with a rectangular housing and two parallel 
rows of electrical connecting pins. The package may be through-hole mounted to a printed circuit board (PCB) or inserted in a socket.

2. Through-hole technology (also spelled "thru-hole"), refers to the mounting scheme used for electronic components that involves the use 
of leads on the components that are inserted into holes drilled in printed circuit boards (PCB) and soldered to pads on the opposite side 
either by manual assembly (hand placement) or by the use of automated insertion mount machines.

Methods Or Technologies of Mounting Electronic Components

1. In electronics, a lead is an electrical connection 
consisting of a length of wire or a metal pad.

2. A die, in the context of integrated circuits, is a small 
block of semiconducting material on which a given 
functional circuit is fabricated.

3. Black plastic housing.
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What is SCH and PCB?

• SCH file is an electronic circuit's schematic created with 
electronics design/simulation programs.

• PCB (printed circuit board)
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Different SCH-PCB CAD software

Altium Designer:
EAGLE OrCADProteus

The name EAGLE is an
acronym, which stands
for: Easily Applicable
Graphical Layout Editor.
The program consists of
three main modules:
Layout Editor, Schematic
Editor, and Autorouter,
which are embedded in a
single user interface.

Kicad
single, unified application that
incorporates all the technologies and
capabilities necessary for electronic
product development.

Altium Designer integrates within a
single design environment:
• board- and FPGA-level system

design,
• embedded software

development,
• PCB layout, editing and

manufacturing

KiCad EDA
A Cross Platform and 

Open Source 
Electronics Design 
Automation Suite

simulator
Design Schematic
printed circuit 
board (PCB) 
editor 

mixed-signal 
simulator
Design 
Schematic
printed circuit 
board (PCB) 
editor.

Fusion 360

Autodesk

Fusion 360, in addition to 
EAGLE’s capabilities within its 
Electronics Workspace, unifies 
tools for MCAD mechanical 
computer aided design, true 3D 
modelling, collaboration, 
documentation, simulation and 
manufacturing, all in one 
application built from the ground 
up.

is a unique 
combination of the 
broad design 
community, a free
PCB Design 
software

Circuitmaker

Altium
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Altium
Australian multinational software company
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Autodesk

Autodesk, Inc. is an American multinational software corporation
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EAGLE is one of many PCB CAD softwares out there. 
1. Cross-platform -- EAGLE can run on anything: Windows, Mac, even Linux. 
2. Lightweight -- It requires anywhere from 50-200MB of disk space (compared 

to the 10+GB more advanced tools might require). The installer is about 
25MB. So you can go from download to install to making a PCB in minutes.

3. Free/Low-Cost -- The freeware version of EAGLE provides enough utility to 
design almost any PCB in the SparkFun catalog.

4. Community support
Whether you want to study the design of an Arduino board or import a popular 
sensor into your design, somebody has probably already made it in EAGLE and 
shared it.

Why EAGLE?
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The first time you open up EAGLE, you should be presented with 
the Control Panel view. The Control Panel is the "homebase" for Eagle, it 
links together all of the other modules in the software.

Exploring the Control Panel
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The control panel

1. Libraries -- Libraries store parts, which are a combination of schematic symbol and PCB footprint. 
• Libraries usually contain a group of related parts, 
• e.g. the atmel.lbr stores a good amount of Atmel AVR devices,
• while the 74xx-us.lbr library has just about every TTL 74xx series IC.

You can explore the 8 separate trees in the control panel, which highlight separate functions of the software:
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The control panel

2. Design blocks
https://manara.edu.sy/
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The control panel

3. Design Rules (DRU) -- Design rules are a set of rules your board design must meet before you can send it off to the fab 
house. In this tree you'll find DRU files, which are a a pre-defined set of rules.

4. User Language Programs (ULPs) -- ULPs are scripts written in EAGLE's User Language. They can be used to automate 
processes like generating bill of materials (bom.ulp), or importing a graphic (import-bmp.ulp).

5. Scripts (SCR) -- Script files can be used to customize the EAGLE user interface. In one click you can set the color scheme and 
assign key bindings.

6. CAM Jobs (CAM) -- CAM jobs can be opened up by the CAM processor to aid in the creation of gerber files.

7. Spice models: programming components

8. Projects -- This is where each of your projects are organized into a single project folder. Projects will include schematic, board 
design, and possibly gerber files.
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Setting the Background Color

• To change the background 
color, go up to the "Options" 
menu and select "User 
interface".

• Inside the "Layout" box you can 
set the background to black, 
white, or a specific color.

https://manara.edu.sy/

https://manara.edu.sy/


https://github.com/sparkfun/SparkFun-Eagle-Libraries
https://github.com/adafruit/Adafruit-Eagle-Library

Add new library
Project path

https://manara.edu.sy/
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https://github.com/adafruit/Adafruit-Eagle-Library
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• Now, when you go back and look at the 
"Libraries" tree, there should be two 
folders included, one of which should be 
our SparkFun Eagle Libraries. 

• The last step is to tell EAGLE that, for 
now at least, we don't want to use the 
default libraries. To do this, right click on 
the "lbr" folder, and select "Use none".

Using" Libraries

Then, right-click on the "SparkFun-Eagle-Libraries-

master" folder, and select "Use all". Then check the 

libraries in each of the two folders. Next to them should 

be either a grey or green dot. A green dot next to a 

library means it's in use, a grey dot means it's not. Your 
libraries tree should look a little something like this:
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Opening a Project and Explore

EAGLE is packaged with a handful of nifty example PCB designs. 
Open one up by expanding the "Projects" tree. From there, under 
the "examples" folder open up the "arduino" project by double-
clicking the red folder (or right-clicking and selecting "Open 
project"). Note that, in this view, project folders are red and regular 
folders are the standard yellow.
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Opening the project should cause two more EAGLE windows to spawn: the board and schematic editors. These are the yin and the yang of EAGLE. They should be 
used together to create the finished product that is a functional PCB design.

• The schematic editor (on the left above) is 

• a collection of red circuit symbols which are interconnected with green nets (or 
wires). 

• A project's schematic is like the comments in a program's code. 

• It helps tell the story of what the board design actually does, but it doesn't have 
much influence on the end product. 

• Parts in a schematic aren't precisely measured, they're laid out and connected in 
a way that's easy to read, to help you and others understand what's going on 
with the board design.

The board editor is where the real magic happens. Here colorful layers overlap and intersect to 
create a precisely measured PCB design. 
Two copper layers -- red on top, blue on the bottom -- are strategically routed to make sure 
different signals don't intersect and short out. 
Yellow circles (on this design, but they're more often green) called "vias" pass a signal from one 
side to the other. 
Bigger vias allow for through-hole parts to be inserted and soldered to the board. 
Other, currently hidden, layers expose copper so components can be soldered to it.

Keep Both 
Windows Open!

Opening a Project and Explore
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• If the dot is green, everything is groovy. If the dot is magenta, a window's probably closed 
that shouldn't be. 

• Second, and more obvious, if you close either of the two windows a big, huge warning 
should pop up in the other:

Opening a Project and Explore

https://manara.edu.sy/

https://manara.edu.sy/


Adjusting the Grid

To turn the grid view on, click the icon near the top-left corner of the board 

window (or go to the "View" menu and select "Grid").

Switch the "Display" radio button over to "On". 
We'll also make the grid a bit less fine by setting the "Size" to 100 mil (0.1") and "Alt" 
to 50 mil (0.05").

Alternate grid   أكثر دقة

2.54 mm=0.1 inch=100 mil
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Schematic
Create a Project

or

Give the newly created, red project folder a descriptive name. 
How about “my_first_project".

Project folders are like any regular file system folder, except 

they contain a file named "eagle.epf". The EPF file links your 

schematic and board design together, and also stores any 
settings you may have set especially for the project.

C:\Users\ESSA\Documents\eagle\proje
cts\my_first_project
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The project folder will house both our schematic and board design files (and eventually our gerber files too). To begin the design process, we need to lay out 
a schematic.  To add a schematic to a project folder, right-click the folder, hover over "New" and select "Schematic".

Create a Schematic

Adding Parts to a Schematic

Using the ADD Tool

Show or hide these toolbars from 
view
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ADD 
PIC16F877
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*atmega328*

search functionality

OR

ADD atmega328
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Add a Frame:

Save (And Save Often)

go to File > Save, or just click the blue floppy disk icon --Name your schematic something descriptive. 

“my_schematic.sch" (SCH is the file format for all EAGLE schematics).

As a bonus, after saving, your frame's title should update accordingly (you may have to move around 

the screen, or go to View > Redraw). Or click F2
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Add LED
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Add Resistor
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Add Power Jack

https://manara.edu.sy/

https://manara.edu.sy/


Add parts

https://manara.edu.sy/

https://manara.edu.sy/


Add Atmega 328p
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Add header

CON PTR 500
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Wiring Up the Schematic

NET does a better job of connecting components.

:لوصل نقطتينnameو labelاستخدام اختصار 

نرسم خط اول •

نرسم خط  ثاني•

اسم الاثنينلاظهارنستخدم ايقونة لابل •

ي على نستخدم ايقونة الاسم لمنحهما و لجعل اسم احدهما مطابقا للثاني و نضغط اوك •

الرسالة الظاهرة

Draw a bus
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Using Bus Wires and Labels
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A part's value allows you to define unique characteristics of that part. For example, 
you can set a resistor's resistance, or a capacitor's capacitance.

The SHOW tool is very useful for 

verifying that pins across your 
schematic are connected correctly.

Show Function and Value Function
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• GROUP COPY PASTE

:النسخ و اللصق لنفس الملف

باختيار ايقونة الغروب داخل الدائرة الحمراء •

ثم تحديد مجموعة من العناصر المطلوب نسخها•

اختيار ايقونة نسخ•

في اي منطقة بيضاء ضمن مساحة العمل كبس الزر اليميني للفارة و اختيار خيار نسخ مجموعة•

أو اختيار ايقونة لصق و من ثم بتحريك الفارة اختيار مكان اللصق و النقر لإنهاء المهمة•

:النسخ و اللصق من ملف لملف

باختيار ايقونة الغروب داخل الدائرة الحمراء •

ثم تحديد مجموعة من العناصر المطلوب نسخها•

اختيار ايقونة نسخ•

فتح الملف الجديد•

اختيار ايقونة لصق و من ثم بتحريك الفارة اختيار مكان اللصق و النقر لإنهاء المهمة•
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D1  D2 D0 D4 D5 D6 D7

• CON AMP QUICK
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• POT
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• RS232-MAX232

This IC is capable of +30V to -30V from RS-232 and shifts the levels down to 0V to 
5V
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RX/RC7/PIN26

TX/RC6/PIN25

RS232-MAX232
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Voltage Regulator
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Add voltage regulator 78L05
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RE2

RD3

Add relay
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Add ANOTHER VOLTAGE SOURCE 12V
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Add relay
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Add Transistor NPN
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Con amp pinhead
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Arduino Uno
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atmega8u2-mu
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CP2102 USB TO 
TTL SERIAL 
ADAPTER

https://manara.edu.sy/

https://manara.edu.sy/


• Using Bus wire
• Label
• Name
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• Label
• Name
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Add frame A4
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Group
Then move each group (right click to 
move a group after selecting it)

Draw lines
Add text

Press F2
Or view-> redraw to update the name based on 
your file name “untitled”
Other like CNAME and rev from edit then global 
attributes

Modify the text by right click on it then properties

Add frame A4- global attributes
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Save as pdf 

From Print
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Click save

EXPORT Bill of Material    BOM
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Open the file arduino_uno.csv  with notepad++ and select all then copy

Open Excel and select the first column and paste

Select all then Open data then text to column

Converts Data csv to Excel
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Converts Data csv to Excel
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Check material online

Electronic Components Distributor - LCSC Electronics
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نهاية المحاضرة
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